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Abstract

OPNET is one of the widely used modelling and simulation software packages in the

telecommunications industry for planning, design, and research and development. In

the wireless modeller module, it uses common propagation models to model radio

propagation.  It  is  also  possible  for  users  to  include  their  own  custom  made

propagation models to run as part of simulations.

This  dissertation  covers  the  study  done  to  integrate  rain  fade  into  OPNET  by

including in one of the propagation models, the ability to access channel information

from an external file and using the data to calculate attenuation along the simulated

radio path.

First the operation of OPNET is summarised, and a simulation model is developed to

demonstrate some functions and results available when performing studies with the

software.

Synthesised fine  scale rain fields  data,  for  use as the  channel  model  data,  was

created.  The  measurement  data  was  obtained  from  the  Chilbolton  Radar

Interference Experiment, CRIE, which was made over a period of two years (1987 �

1989) at Chilbolton Advanced Meteorological Radar (CAMRa) station.

Then, the free space propagation model available in OPNET was modified to read

rain fade time series data from an external file, and to use the data to scale radio

signal  levels  between  transmitter  and  receiver  models  in  simulations.  Shared

libraries to enable  the  running  between OPNET and the customised  propagation

model were to be created, but due to limited time, these were not completed. Hence

the customised model was not tested in OPNET.

It is presented, as recommendations for future work to further explore the capabilities

of OPNET, and to complete the creation of the shared libraries not achieved in this

project, and finally to test the propagation model with rain fade by investigating the

availability of route diverse radio link implemented as a Fade Mitigation Technique.
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Chapter One � Project Introduction

Communication systems and network developers nowadays use simulators to gain

insight into the behaviour of their products and networks before committing time, and

other resources to the physical objects they are designing. 

A number of simulation software packages exist in the market, each with its strong

and weak points, mainly because they were designed with specific goals in mind, to

solve  certain  problems.  One  of  these  packages,  which  is  widely  used  in  the

telecommunications industry, and Research and Development (R & D), is OPNET. 

The software consists of a comprehensive variety of tools that can be used to study

behaviour  and  performance  of  telecommunications  network  nodes,  modules  and

processes.  In the  radio module, it  is  capable of modelling  all  the  aspect of radio

communications.  This  project  aims  to  explore  some  the  functions  available  in

OPNET.

1.1 Project objectives

The aim of the project is to study the operation of OPNET wireless modeller and

apply rain fade in one of its radio propagation models. The modelling of processes,

modules, nodes, links and networks is studied. As a demonstration of how simulation

can be utilised, the performance of a route diverse link in a rain fading channel is

investigated. 

The process of the project execution entails:

· learning how to work with OPNET modeller, 

· generating  fine  scale  rain  fade  time  series  data  from  Chilbolton  Radar

Interference  Experiment,  CRIE  measurements  done  at  Chilbolton  Advanced

Meteorological Radar, CAMRa to model radio channel rain fade

· understanding  C  programming  language  code  and  modifying  the  free  space

propagation model to include rain fade as modelled with the time series data from

an external file
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· run simulations of a route diverse link to study the impact of rain fade on the link

availability

To simulate the impact of the rain fade on the radio channel, the propagation model

available in OPNET is modified and used to import rain fade time series data from an

external file and the data used to model the link radio channel. 

The  ITU-R  P.530-12  is  a  rain  fade  model,  recommended  by  International

Telecommunications Union (ITU) that provides a method to predict the signal fading

experienced  by  Line  of  Sight  (LOS) microwave  links  as  a  result  of  precipitation.

However, the prediction is limited to only one hop in a link and does not provide any

indication for  the  availability  of  either  multi-hop  or  route diverse  links,  which  are

deployed as Fade Mitigation Techniques (FMT). It is desirable to have an idea of the

availability of links with a number of hops, and those that are route diverse at the

receive end. 

The project attempts to characterise the availability  of  a route diverse microwave

link,  by  simulating  two  paths  of  the  link  when  exposed  to  rain  and,  from  the

information data quality at both receive points, calculate the overall availability of the

link.

1.2 Limitation of the project

The OPNET simulation package is extensive in the number of functions and details

of the systems it covers for simulation. It therefore requires a lot of time to appreciate

the operation of the modules.

The  project  period  is  little  more  than  10  weeks,  which  is  a  short  time.  As  a

consequence,  the  project  focuses  only  on  the  learning  and  creation  of  a  radio

network (fixed link) within the wireless modeller, its parameters� setup,  simulation

and collection of results. 

The programming language used to create the model, C, is new to the researcher,

and  therefore imposes further  limitation on the time as some appreciation of the

language has to be developed before it can be put to use.

Finally, the online help available from OPNET Technologies was not accessible as

the subscription fees for the service was in excess of the project budget. This implies

2



Chapter One � Project introduction

a slower pace in learning the software and limits the width of coverage of functions

within the project period.   

1.3 Report structure

In chapter two, modelling and simulation are summarised, emphasising the benefits

of their application in R & D, planning and designing of telecommunications network

modules and complete networks. The final part of the chapter deals with the specific

modelling and simulation package, OPNET, that is discussed to some detail, and its

properties are summarised.

Chapter three deals with radio wave propagation and attenuation which leads to the

investigation of rain fade in telecommunication radio links. The discussion forms a

prelude to the subject of rain fade models, and finally the ITU-R rec. P.837.12 that

models the rain fade for microwave LOS links.  Further,  development of rain fade

time series data from meteorological radars for use in modelling radio channels in

rainy environments is looked at. The rain fade time series data finds lot of application

in developing FMT.

Chapter four describes procedures followed to execute the project. The creation of

the various sub-components of modules and processes in OPNET is summarised,

and the details of customising the free space propagation model to include rain fade

is addressed. The last portion of the chapter relates the procedures followed in the

execution of the simulations undertaken in the study project.

Chapter five presents the results and achievements of the project and discusses the

implications  of  the  findings.  The  learning  acquired  and  practical  insights  on  the

concepts dealt with in the investigation are put into perspective.  The outcome of the

demonstration study of obtaining results is also outlined. 

In chapter six, conclusions and suggestions for future work on the development of

the subjects studied in the project are advanced. 

3
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Chapter Two - Modelling & Simulation, and OPNET

2.1 Introduction 

Usually, software simulation packages are utilised during the planning and design

stages of communication systems to learn the response of the system performance

to  changes  made  on  particular  parameters.  This  chapter  explores  the  field  of

Modelling and Simulation, and then discusses the specific package of interest in this

project, OPNET.

2.2 Modelling and Simulation

Modelling and Simulation (M & S) is a tool designed to evaluate the performance of

a system,  either  existing  or  proposed,  and can be used to study  the  effects  on

performance of different configurations of a system .The process is useful to gain

insight into the behaviour of complex systems. A model of sets of inputs, algorithms

and routines  which  define  the  behaviour  of  a system is first  created.  Simulation

represents the execution of the model. The user defines the inputs and, through

simulation  outputs  such  as  bit  error  rate  (BER),  packet  error  rate  (PER),  and

throughput are obtained to get insight into the system performance .

M & S is a critical element in the design and development, and test and evaluation

(T & E) of a network product or solution . It is preferable to have insight  into the

behaviour  of an algorithm or  device to see how it  will  perform in the  real  world

before deployment or production.

In network design, it is important to ascertain that the introduction of an element into

a system will not have unintended consequences. Due to the growing complexity of

communication networks, the role of M & S is expected to grow rapidly in the future

as Burbank  notes. The reason for this is the nature of present systems that have

distributed  functional  subsystems  which  operate  as  a  whole,  and  which  cannot

usually be tested in isolation since the system level performance is often of primary

interest.
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2.2.1 Advantages and Limitations of M & S

M & S avails the ability to exercise scenarios not easily achievable through empirical

methods.  Through M & S,  it  is  also possible to test  system sensitivity  and tune

performance. These have the advantage of allowing engineers to study the design

without incurring too much cost and time building a physical test network  and . The

reduced cost and  time also offers  an opportunity  to systems learners to have  a

better  experience,  by  working  with  the  visualised  structures  of  systems  and

protocols as implemented in simulation packages.

The results of M & S should, however, be treated with caution. The reason for this is

that the model is fundamentally not real. The simulation results are only a function

of the aspects of the model and the degree of detail to which the model delves into

defining the aspects. The effects of other elements not addressed in the model have

to be catered for somehow in the analysis and use of the M & S results . 

The  other  very  realistic  obstacle  is  the  availability  of  the  software.  The  cost  of

purchasing and maintaining licences can easily run into tens or even hundreds of

thousands  of  pounds  depending  on  the  number  of  users  (licenses),  and  the

elements included in the package. This cost factor limits access for learners who

would otherwise gain from practising communication protocols, systems and design

aspect that the simulation packages present a little nearer to reality, as opposed to

the theoretical treatment that is dispensed in the classroom. 

Further,  after  M  &  S,  empirical  testing  is  still  necessary.  Analytical  models,

prototyping, laboratory and field tests must be carried out to ensure a successful

design .

2.2.2 Commercially available simulator packages

Simulation modelling is becoming popular for network performance analysis. Many

simulation software packages exist in the market, e.g. REAL, NS-2, etc, each with

its specific strong performance point. An effective simulator is built in a modular and

hierarchical format, as well as having graphical capabilities .

OPNET has become one of the most widely used software simulation packages in

industry and learning institutions (with reduced capability and maintenance costs). It

6



Chapter Two � Modelling & Simulation, and OPNET

is  object-oriented  and  meets  all  the  requirements  of  an  effective  simulator.  It

provides comprehensive development environment for the specification, simulation

and performance analysis of communications networks . 

Comparison studies have been made by Garrido  between the performance of NS-2

and OPNET, which showed generally similar results. However, OPNET has been so

taken up in the Research and Development (R & D) as it has a detailed approach

that allows the building of complete networks for investigation. 

2.3 Overview of OPNET modeller

OPNET, short for Optimised Network Engineering Tools, is a vast software package,

covering almost all aspects of communications networks and systems. The focus of

this discussion shall be very limited, attempting to touch only on the subjects that

will be applicable in the study ahead.

With OPNET, models of physical layer link transceivers, antennas, CPU that  runs

processes  to  manage  queues  or  running  protocols  can  be  constructed.  Using

OPNET  programming,  any  protocol  packet  format,  state  transition  machines  for

processes  running  protocols,  process modules and transceiver  modules for  each

device node can be defined. The network can then be assembled by connecting the

device nodes together using user defined link models .

The environment provides a logical structure built on hierarchical models to achieve

a system that can allow the simulation of complex and large networks. 

The installation of OPNET involves a straight forward procedure. The small hurdles

experienced mainly  had  to do with the  operating  system security,  which blocked

some of the software functionality.  However, having appropriately set the security

procedures, the software has a guiding installation process.

Further, the system environment settings should be appropriately configured to link

the  external  compiler  for  execution  of  some  processes  during  simulations.  The

settings are available in OPNET tutorials literature.

2.3.1 Structure of OPNET network element models

Two fundamental methods comprise the description of structures in OPNET models.

7
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These are the objects � physical representation of network elements, and procedures �

behaviour description of the network elements.

Objects in OPNET represent structures of communications networks. This concept

also applies to substructures that represent the internal decomposition of the objects

which can be referred to as sub-objects. Sub-objects operate together to achieve

some functionality that forms a characteristic of the main object. Some objects are

non-physical, and include elements like processes, packets, timers, etc. They usually

do not have a visual representation in OPNET schematics.

Models are used to define object characteristics. Any change to aspects of a model

effects  change  to  all  object  aspects  inherited  from  the  model.  However,  other

variables  in  objects  are  parameterized  and  exposed  for  modification  by  users.

Therefore, objects of the same model can be different.

Objects have private and exposed characteristics.  The private characteristics are

hidden away from the user and cannot be modified. The exposed characteristics are

known as attributes, and can be associated with the whole model, a class of objects,

or one particular object. With the use of attributes, users can provide information,

specify general characteristics, select behaviours,  or modify internal  structures for

models  and  objects.  Attributes  can  assume  different  data  types,  i.e.  logical,

numerical, text, etc. 

The specifications of objects in the Node are defined by the Process which is the

hierarchical component below the Node .

The modelling process in OPNET consists of first creating a project. The project has

a scenario in which the topology, traffic, and results and reports to be collected are

specified. The simulation is run and results are viewed within the scenario .

Within  the  project,  it  is  possible  to  change  settings,  re-run the  simulations  and

compare the results to learn the impact of the changes.

In general, in building a test model in OPNET, one can specify the functionality of

the units he/she wishes to emulate in a network situation. From network nodes, the

modules  that  constitute  the  nodes,  and  down to  software  controlled  processes.

8
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Moreover,  one  can  use  models  of  many  commercially  available  network

components, from major hardware manufactures which OPNET has in its libraries.

2.3.2 The wireless component of OPNET modeller

For simulation of radio networks, OPNET uses the Wireless Modeller. The module

has all  the aspects necessary to simulate the various radio network systems, i.e.

fixed, mobile and satellite stations. 

2.3.3 Simulation

OPNET simulations are event-driven. Events are activities that occur at certain times

and when an event occurs, OPNET simulation time advances. This has a number of

advantages  over  real  time  simulation.  The  accuracy  of  the  results  is  not

compromised  as  a  result  of  limited  sampling  resolution.  Also,  simulation  is  time

efficient as there are no moments when there is nothing happening. 

The radio link

Packets  are  broadcast  and  replicated for  each of  the  selected destinations.  The

packets  are  then  analysed  and  modified  independently  in  accordance  with  the

transmitter � receiver link path conditions. 

In  OPNET,  the  radio  links  are  not  visible  in  the  network  model.  The  links  are

dynamically created during simulation. To establish a link between transmitter and

receiver channel pair, many physical characteristics of the components involved and

time-varying parameters have to be taken into account .

Connectivity

Since  radio  links  depend  on  dynamically  changing  parameters,  the  transceiver

pipeline must evaluate the possibility of connectivity between transmit and receive

channel for each transmission.  This evaluation considers elements like location of

nodes  (receivers  and  transmitters),  separation  distance  between the  nodes,  and

direction of travel of signal (as determined from antenna directivity). For mobile and

satellite nodes, the location and related parameter normally change continuously as

per the defined trajectory.

The relative positions of the transmitter and receiver nodes to each other also play

9
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an important  part in deciding the connectivity possibility.  If there is an obstructing

object  or  earth�s  surface  between  them,  the  source  and  destination  nodes  are

occluded, no connection can be created and, depending on the propagation model in

use, the simulation terminates.  With no obstructing objects, the link closure exists

and the link simulation goes ahead.

The simulation also calculates the propagation delay and path loss of the signal. The

delay is determined from the distance separating the source and destination, and the

speed of the signal, taken to be equal to that of light. The path loss assumes the free

space model and which the loss is taken to be directly proportional to the inverse of

the  distance  squared.  The  model  can  be  changed  by  taking  one  of  the  many

included or importing one defined by the user.

The  power  of  the  signal  also  depends  on  the  antenna  directivities.  OPNET

simulations  take  into  account  transmit  and  receive  antenna  directivities  in

determining transmitted (e.i.r.p.) and received power .

Simulation efficiency

Due to the huge number of calculations that wireless simulation involves, it can be

quite time consuming. Therefore, the OPNET wireless module provides methods to

mitigate the time required to run the simulations. One can choose to execute pipeline

stages in parallel, reduced the number of pipeline calculated, reduce the number of

site positions and/or duplicate packets for receivers that can actually receive them .

10
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3.1 Introduction

Radio  waves  used  for  information  transmission  in  electronic  communications

systems experience attenuation and distortion as they travel through space between

the sending and receive points. One of the major tasks confronting communications

systems design engineers is the design of fade and distortion mitigation techniques

to maximise the capacity of information carrying systems.

During the planning of a radio transmission system, proper allowance has to be

made  for  attenuation  processes  so  that  they  do  not  completely  suppress  the

information transmission. The radio link power budget is calculated to establish the

required transmit power given the receiver sensitivity and the envisaged extent of

the signal attenuation along the propagation path.

The discussion that  follows looks at the general  causes of radio signal fade and

distortion. It then focuses on the rain attenuation mechanisms as experienced by

radio waves, then touching on the general rain fade modelling approaches.  The

final  portion  addresses  the  model  recommended  by  the  International

Telecommunications  Union  (ITU),  Rec.  ITU-R  P.530-12,  which  provides

mechanisms for prediction of rain fade in the planning of line of sight microwave

links.

3.2 Radio wave propagation and attenuation

Before delving into the dynamics of rain fade, it is important to briefly discuss the

way radio waves in the microwave frequencies propagate and the likely causes of

degradation they may suffer as they travel.

In the microwave region, radio frequencies of 1 GHz to 300 GHz, the propagation of

waves is predominantly LOS. Unlike at lower frequencies,  ground reflections are

less  pronounced  because  the  ground  roughness  is  greater  compared  to  the

wavelengths at these frequencies . However, as Collin  further notes, over smooth
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surfaces,  and  particularly  over  appropriately  large  water  bodies,  reflection

interference  can  become  more  significant  due  to  stronger  specular  reflection

components.

The  important  factors  at  wavelengths  of  a  few  centimetres  and  under  are

attenuation and scattering by rain and snow, and by fog, water vapour and other

atmospheric gases at even lower wavelengths . Radio waves generally interact with

media of similar dimensions as their wavelength. Rain drops diameters range from

one millimetre to about 10 mm and these are comparable to the wavelengths of 10

mm for radio waves at frequencies around 30 GHz. Hence, at these frequencies,

radio waves suffer extreme attenuation due to scattering by rain . 

For  microwave  terrestrial  communications  purposes,  these  are  the  important

factors. However, for space communications systems, such as satellites, elements

outside the atmosphere, like the ionosphere, come into play.

3.3 Rain fade in radiocommunication systems

Rain fade refers to the attenuation of RF signals due to precipitation along the path

of propagation of the signal. It is one of the dominant causes of radio link outages,

especially  at  high  frequencies,  around  5  GHz and  above  where  its  contribution

becomes even more significant , .

 According to the ITU recommendations, outage can be defined from the duration of

sustained sending of wrong bits. Digital data are sent in blocks of bits on bursts of

radio emissions. If a bit in a block is incorrectly transmitted, the block is said to be

"errored�. A time duration of one second is termed Severely Errored if more than

30% of the blocks transmitted within the second are errored. The second is then

called the �Severely Errored Second�, abbreviated SES. Outage is defined by the

period between the first of ten successive SES and first of ten successive non-SES. 

Radio links are specified to have outage period caused by rain fade not exceeding a

small percentage of an average year, normally 0.01% or 0.1% of the time, and rain

fade margin is built into the link budget by estimating the attenuation exceeded for

this time. The models are based on available statistics of rain rate measured over a

one-minute integration time. They are good for  long link,  but may underestimate

outage for links shorter than 1 km . 
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3.3.1 Rain drop size characterisation

The attenuation of radio waves due to precipitation depends on the radio system

parameters and the precipitation parameters. System parameter include the radio

parameters like frequency, polarisation, network parameters like geometry of links,

link length elevation, network topology, etc, and precipitation parameters e.g. rain

rate and drop size distribution .  

Zhang  discusses a number of methods to characterise rain drop size distribution.

More detailed analysis  is  done  by Laws and  Parsons   which tabulates  the  size

distributions.  Marshall and Palmer  proposed an empirical exponential method to

characterise drop size distribution. The Marshall and Palmer method is widely used

for meteorological and radar applications .

Other rain drop size distribution models include the exponential linked to event type

proposed  by  Josh  and  Waldvogel  ,  where  they  split  rainfall  rate  into  three

categories, i.e. drizzle, widespread and thunderstorm for purposes of characterising

their drop sizes; and the gamma distribution  proposed by Ulbrich and Atlas .

3.3.2 Rain rate characterisation

The rate at which rain falls is one of the major factors to consider when analysing

the impact the rain has on the radio propagation through the rain.

Rain attenuation distribution data are derived from point rain rate statistics. The 0.01

percent exceeded level is generally estimated from at least five years of link rain

fade  data.  For  those attenuations  that  occur  with  lower probabilities,  even more

monitoring is required. Locally derived statistics of rainfall  rate with a one minute

integration time are preferred for calculation of radio signal rain fade .

The key parameter used for rain rate distribution is the rate exceeded for a given

percentage in an average year. ,�-0.01. denotes an averaged rain rate over

a  period  of  one  minute  and  exceeded 0.01  percent  of  an average  year  in  the

geographical region of the radio link . The ITU recommendation Rec. ITU-R P.837-5

provides  the  annual  statistics  for  the  whole  world  as  a  function  of  latitude  and

longitude derived from numerical weather models.

Two methods are available to calculate rainfall rate distribution for a region. In the
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empirical method, the field measurements and recordings over long periods of time

are used. Another method employs the use numerically derived weather prediction

simulations  such  as  the  Rec.  ITU-837  and  the  Global  Crane  model.  The  two

methods generally yield much different results as shown by Myers .

3.3.3 Rain drop shape characterisation

Due to surface tension,  small  rain drops remain spherical in shape. But the drag

from the air as the drop falls through it, distorts the shape away from spherical. The

distortion leads to an oblate spheroid with a flat base. For drops with a diameter of

above 4 mm, the base tends to become concave .

The  analysis  of  rain  drop  shape  has  been  studied  for  some  time  and  Zhang

discusses in some detail the different approaches. One of these is the Pruppacher-

and-Pitter model, which is the most favoured in research on calculating microwave

rain attenuation. The model predicts the rain drop to change shape from spherical,

to spheroidal and to a terminal Pruppacher-and-Pitter shape .

A rain drop is said to be canting when its axis is not symmetrical. With strong vertical

wind shear, many rain drops will usually have similar canting angles. This results in

some exchange of energy between horizontally and vertically polarised waves.  It

has been suggested that, from cross-polar calculations, the drop falls such that its

symmetry axis is parallel to the velocity of the air flow relative to the drop. Links of

up to 40 m above ground will have a canting angle of about 5 degrees . 

Due  the  rain  drop  shape  deformation  as  discussed  above,  the  radio  wave

propagation  is  changed.  At  low  frequencies,  horizontally  polarised  waves

experience more attenuation and phase shift due to the rather big width of the drop

compared to the height .

3.3.4 Rain fade dynamics

To  quantify  the  level  of  rain  fade,  it  is  also  important  to  learn  the  dynamics

associated with rain fade. 

The rain fade slope refers to the rate of change of rain attenuation and is essential for

determining the required tracking speed of fade mitigation techniques. This property
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is dependent upon the attenuation level, sample time and climatic parameters .

The  fade  duration indicates  the  time  length  during  which  the  attenuation will  be

above a certain threshold value. It is useful in communications systems where the

length of an outage is critical and in the design of fade mitigation techniques which

make use of shared system resources .

Frequency scaling of attenuation provides the possibility  of predicting attenuation at

one frequency using the knowledge of the other measured at another frequency.

The scaling can be instantaneous or long-term (statistical). Instantaneous scaling is

applicable in mitigation techniques that  predict  attenuation on a link in real time

while the long-term statistical scaling is used for attenuation at one frequency when

the statistics at another frequency are known  and .

The preceding rain properties and dynamics are used in creating models that help

to predict the attenuation that rain impacts on radio signals as they travels through

rain  and  space.  Another  application  is  in  the  implementation  of  fade  mitigation

mechanisms meant to minimise signal degradation.

3.4 Rain attenuation and rain fade models

 Rain attenuation is dependent upon a number of random time-variant parameters,

some of which have been discussed above. In addition to the parameters mentioned

above,  others  include  raindrop  temperature,  spatial  variation  of  rain  parameters,

wind velocity, etc  and . Some insight is available of the impact on rain attenuation as

related to frequency and drop size as studied by Tat-soon Yee et al. .

The  total  attenuation  A  along  a  radio  path  of  length L  with  rain  falling,  can  be

evaluated from the equation

��=�.���,�- -,�-���.�(�).��

(1)

,�-���. is the total extinction cross section of the particle given by 
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,�-���.=,,�-�.-�.��,�,�..  

(2)

�,�. is a dimensionless function of scattering angle � and �,0. is the forward

scatter cross-section , .

Specific  attenuation  is  defined  as  the  attenuation  in  dB  per  unit  length  of  the

propagation path � and is calculated from

�=,,���-���.-�����,�-�.., ��-��.

(3)

The total attenuation can be evaluated from the integral of the specific attenuation as

�=,�-�-�(�).�� ��

(4)

It is not common that the specific attenuation for a specific path is known, but it can

be estimated by transforming the historical point rain rate distribution for the region.

The transformation is, however very involving. Many models usually include a factor

to reduce the effective path length to allow for the spatial rain intensity. The path-

reducing factor,  r, depends on path length and rain rate . In the Rec. ITU-R P.530-

12, the path-reducing factor is calculated as follows;

The aim of rain fade models is to produce rain fades over an average year. The

average can then be refined to estimate the worst month performance. The models

are  designed  to  yield  results  for  link  rain fade  margin and  spectrum regulations

purposes .

There  are  two  categories  of  rain  fade  models.  One  category  is  derived  from

measured or  modelled  rain field.  The  other  category  is  derived  empirically  from

measurements on many links situated at different locations.

There are two rain fade models extensively used for in microwave systems design.

One is the Rec. ITU-R P.530-12 which is based on the Rec. ITU-R P.837-5 ,�-

0.01. climate maps, or local measurements where these are available, and the
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Rec. ITU-R P.838-2 parameters for the specific attenuation calculation.

The other model is the Crane model which is primarily based on the Crane climatic

model. It is of particular interest for applications in North America .

3.4.1 The Rec. ITU-R P.530-12

Rain attenuation is a result of a variety of elements, many of which were discussed

in an earlier section on Rain fade in radiocommunication systems. The attenuation

is also related to other variables with complex relationship. These include.

The total radio propagation loss is a sum of contributions from a number of factors

that  include  attenuation due atmospheric  gases,  diffraction and multipath fading,

arrival and launch angles, sand and duct, and, particularly at frequencies above 5

GHz, precipitation.  These factors generally have dependence on frequency,  path

length and geographical location of the link .

Rec. ITU�R P.530-12 is the ITU recommendation for calculating estimates of rain

fade in the design of LOS microwave links. The recommendation makes use of Rec.

ITU-R P.837-2 and Rec. ITU-R P.838-1. 

Rec. ITU-R P.837-2 provides methods to estimate the intensity of precipitation, ,�-

�., and information needed for worldwide locations with a range of probabilities, �,

for  use  in  the  prediction  of  attenuation  and  scattering.  The  model  utilises  data

derived from the European Centre of Medium Range Weather Forecast (ECMWF),

collected  over  15  years.  Using  the  data  (available  from  the  ITU),  the  various

variables can be determined. Having determined the variables, the rain probability,

,�-0. is calculated, and ultimately, the rainfall rate, ,�-�. can be evaluated . 

Rec. ITU-R P.838-1 provides a method to calculate rain attenuation, from which the

specific attenuation can be determined . 

The ITU-R P.530-12 model makes use of local sources of long-term measurements.

If local statistics are not available, Rec. ITU-R P.837, as summarised above, which

evaluates  rain rate  ,R-0.01. exceeded 0.01% of  the  time,  can be used to

estimate the statistics.  The  Rec.  ITU-R P.838-1 is then applied to determine the

specific attenuation,  ,�-�.��/�� for the frequency, polarisation and rain rate

,�-�..
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,�-�.=�,�-�.  

(5)

In view of the fact that the rain does not  usually exist throughout the propagation

path, the effective path

 ,�-���.=�������  �������� ������, �

(6)

is evaluated. � is derived as follows

�=,�-(�+,�-,�-�..).

(7)

where  ,�-0.=35,�-�0.015,�-0.01..and  ,�-0.01. is  the

rainfall rate with an integrating time of 1 minute that occurs for 0.01% of the time and

� is the path length .

The distance factor can be estimated for different rain rates  ,�-�. exceeded �%

of the time, as specified in .

 The path attenuation exceeded for 0.01% of the time is the estimated from 

,�-�.��.=,�-�.,�-���.

(8)

For different latitudes, the estimate for the ratio ,,�-�.-,�-0.01.. can be

deduced with the use the criteria provided for a set of percentages,  �. Hence the

path attenuation exceeded for the �% of the time,  ,�-�. can be calculated. 

3.5 Rain fade time series data from meteorological radars

Meteorological radars provide rain rate data for some areas. The data is collected for

use in weather and other services and has some crude time resolution. For radio

systems optimisation, more accuracy is required on the data, but the measurements

of  the  acceptable  accuracy  are  not  available,  hence  attention  has  turned  to

synthesising more accurate rain fields for use in telecommunication systems for their
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feasibility and efficiency studies . 

3.5.1 Meteorological radars

Meteorological  radars  collect  data  used  in  weather  forecasting  and  warnings  for

severe weather.  These  radars measure rainfall  using the  fact  that  the amount  of

power reflected from the space containing rain, and the rain rate are related to the

DSD .

In measuring rain, meteorological radar measures an ensemble of targets in the form

of rain drops.  The power received consists  of vector  contributions from individual

reflected powers from falling hydrometeors. The power varies randomly from radar

pulse to pulse as a result of movement of the precipitation within the volume. This

becomes independent over periods of 10 ms . 

Therefore, meteorological radars have to average several independent samples to

achieve a reliable echo estimate from each volume. Within a sample volume, rain

drops will  yield the same reflectivity whether  stationary or falling,  and a range of

DSD, each with an associated rain rate, will yield the same radar reflectivity. 

Many types of meteorological radars operate by estimating rain rate. To verify the

estimated values, the rate is compared with local sources such as rain gauges which

can also help reveal possible calibration errors in the radar measurements.

Radars calculate rain rate from the reflectivity factor. The reflectivity factor is then

converted to rain rate using the power law Z - R relationship:

�=�,�-�.

(9)

Z is the radar reflectivity factor, R the rain rate, and a and b constants , .

Various versions of the Z � R relationship exist for different rain types and radars .
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3.5.2 The Chilbolton Advanced Meteorological Radar (CAMRa)

CAMRa is a dual-polarisation, Doppler radar operated by the Chilbolton Observatory

to collect weather data and, sited in southern England. The dual polarisation nature

allows it to alternate between vertical and horizontal polarisation from pulse to pulse.

The data used in this project were acquired from the Chilbolton Radar Interference

Experiment, CRIE. The data were collected from 1987 to 1989 and provide detailed

samples of rain events experienced in Southern England during the period.

The data were captured in an 18 days on; nine days off cycle, with CAMRa scanning

both horizontally and vertically every 10 minutes over a 50 degree horizontal sector

and a range of up to 160 km .

3.5.3 Fade mitigation techniques

Most radio link system mostly operated at low frequencies whose performance was

not adversely affected by rain. But the requirement for more bandwidth in modern

wireless technologies  has  dictated either  more  spectrum efficient  technologies  or

higher frequencies, which happen to be more prone to rain fade, be used .

Fade mitigation techniques seek to compensate for  rain attenuation.  There are a

number of  approaches  to achieve  the mitigation,  and these include  the Adaptive

Transmit Power Control (ATPC), and diversity methods. In ATPC, the transmit power

is increased dynamically in response to the level of attenuation being experienced.

Diversity techniques utilise different sites or routes, placed far apart for better de-

correlation, so that the link traffic can be switched through the node experiencing the

least fading.

Synthesised  spatial  and  temporal  varying  rain  fields  can  be  produced  from

meteorological  radar  measurements,  which  may also  be customised  for  different

climatic regions. The fields can be converted to simulated attenuation time series

and applied to radio network simulations . The work by Zhang  produced a method

which synthesised scan times of 10 s from the 10 minutes of the original CRIE data. 
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Following  the  learning  of  how  OPNET  operates,  much  of  which  was  achieved

through the use of  the  documentation available within the package, and  through

practice, a network model was created and some simulations executed as described

hereafter. This chapter describes:

· The creation of a radio link model in OPNET

· The creation of fine scale rain fade time series data from the CRIE data

· The accessing and modification of the propagation model to include rain fade

· The creation of shared libraries linking the propagation model programme and

OPNET environment

5.1 Radio link model creation1

The first step in setting up a network model in OPNET is to define the characteristics

of the modules that make up the network nodes. For this case of a radio link model,

the modules were: 

· the antenna  

· the pointing processor  for the receive antenna

· the radio transmitter 

· the radio receiver modules

The  attributes  of  the  modules  were  modified  to  achieve  the  specific  functioning

desired for the simulation carried out. Two types of transmitter models were used;

the model for a normal packet transmitter and the jamming transmitter to simulate

background radio noise. The step by step method of creating the module models is

in appendix A.

1 The procedure is adopted from the OPNET tutorial, �Creating a wireless network�
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5.1.1 Antenna module

An  antenna  module  that  models  a  physical  antenna  was  created  and  its

characteristics defined.  Using  the default  omni  directional  module in OPNET,  the

directivity, gain, and radiation pattern were defined using the antenna pattern editor.

Figure 4.1 shows the finished antenna pattern model; it  is a high gain directional

antenna model.

Figure 1: Antenna radiation pattern model

The directional antenna module was used in the receiver nodes. In the jammer and

transmitter nodes the default omni directional module was used.

5.1.2  Pointing processor 

The antenna pointing processor is a software module whose function is to steer a

receive antenna towards a target transmitter. The processor contains a function that

references  the  target  transmitter,  and  achieves  the  tracking of  the  transmitter  by

calculating the coordinates of the transmitter from its model attributes.

For this project, an example C++ code from one OPNET tutorial was used with a few

modifications to some parameters to produce the desired processor function for the

task at hand.

The pointing processor was included only in the receiver node models.
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5.1.3 The transmitter and receiver node models

The  transmitter  and  receiver  models  resemble  each  other  with  three  major

differences: 

· the receiver node includes a pointing processor while the transmitter node has

none,

·  the transmitter node has packet generator whereas the receiver node has packet

sink, and 

· the packet stream directions point in opposite directions in the two nodes.

The transmitter, jam, and receiver nodes were created as depicted in figures below.

Figure 2: Transmitter and jam node model

Figure 3: Receiver node model

The  jam transmitter  is  similar  to  the  transmitter,  but  internal  attributes,  such  as

modulation  and  link  (it  was  mobile  in  this  case)  are  set  different  to  that  of  the

transmitter.

5.1.4 The network model

A  simple  route  diverse  link  model,  as  illustrated,  was  created  in  OPNET.  The

transmitter  has  an  omni  directional  antenna  and  sends  data,  picked  up  by  two

directional antennas at  the two receive points,  receiver 1 and receiver 2, that  are

spatially separated. The information signal, therefore, spreads in different paths and
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experiences different channel characteristics, en-route to the receivers. 

Figure 4: Schematic of a route diverse link

Having defined the appropriate process and node models in sections 4.1.1 to 4.1.3

above, the network model was created.

First,  a  project in  OPNET was created.  The  scenario under  the  project  was  then

established, specifying the scale of the network as campus (a small network), and the

dimensions of the area it covers. Many scenarios can be created under a project to

address different investigation aspects.

The  object palette is a module that contains the network node models, including the

ones created in this project. There is an overwhelmingly large number of models in

the object palette. Therefore, to avoid confusion,  a palette specific for this project

was created and given a name. This was done by deleting all other models, and

leaving only the ones defined above, using the configure palette function. 

Within the scenario workspace, using the object palette, the network model was then

created. The process involved dragging the node models from the object palette onto

the workspace, placing them to build the layout of the network being modelled. After

this  stage,  the  node  model  attributes were then modified  to define  their  function

within the network model.  The model attributes were accessed by right-clicking on

the node model and choosing edit attributes. 

The node interface attributes were used to configure the node models position and
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declaring if node is mobile, fixed or satellite.

Figure 5 below shows the completed network model. Note the different appearances

between the jammer and transmitter models; the jam has a number of arrows on the

symbol, indicating it is a mobile node.

Since the jammer was configured to be mobile, a trajectory was defined as seen on

the figure by the arrowed line. The trajectory was defined using the define trajectory

function under the topology menu in the project workspace. The jammer node follows

that route during the simulation.

The jammer was included to mimic the possible background radio environment that

could cause errors in information transmission along the two routes. The interferer�s,

or jammer�s, trajectory cuts through the link routes in turn. As a result, it degrades

the performance on the two routes, at different points in simulation time.

Beyond the receivers, there is some post-processing to combine the availability of

the  signals  from the  two  sources,  receiver  1  and  2.  The  aim was to  study  the

performance  statistics  of  the  link  at  the  receive  points,  as  the  route  channels

between  the  transmit  and  receive  ends  are  modified  to  simulate  varying  rain

attenuation.

Figure 5: A dual route radio link model
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5.1.5 Packet generation and receive error model

In the transmitter node, the packet generator module was configured to the default

settings of 1024 bits per packet, produced at the rate of 1.0 packets/second. The

packets then pass into the transmitter via the packet stream 1024 bits/second.

In  the  receiver  module,  an  error  allocation  model  was  used  to  define  when  a

received packet is in error. The chosen scheme has an Error Correction Code (ECC)

threshold of 0.0 errors/bit,  meaning  any  packet  with a least  one bit  in  error  was

discarded.

From the received packet, the sink processor determines the Bit Error Rate (BER),

packet  throughput  (packets/second),  and  received  power  are  monitored  and

recorded and the results analysed for various conditions.

5.1.6 Results collection set up and running simulations

Having  constructed  the  network  model,  the  required  statistics  were  specified.

Because there is a vast number of statistics available, a lot of disc space would be

required to store them if they were all to be collected. OPNET allows users pick the

statistics that are required in a simulation, using the probe function. 

5.1.7 Specifying results to be collected running the simulations

Three types of probes exist in OPNET, namely a statistics probe, an animation probe

and an attributes probe. They have their specialised purposes for displaying output

from various network aspects in special ways. The statistics probe was configured to

collect node statistics, which include packet throughput and error rates.

Running the simulations at this stage was meant to test the model and demonstrate

the way to collect the statistics. The simulations were run and the statistics extracted

for each receive node, and correlated in time to observe the difference in the results.

5.2 Generation of rain fade time series

The channel information data used for simulating links was generated from the CRIE

data measured by the CAMRa. The CRIE data were scanned every 10 minutes, with

a spatial resolution of 300 m by 300 m. However, for simulation of radio networks, a

finer  sampling  period  is  preferable.  Therefore  the  algorithm developed  by  Zhang
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(2008) was used to synthesise the fine scale rain fade time series at 10 seconds

sampling periods, reduced to 30 m spatial resolution using Matlab. 

In brief,  the  Matlab program, developed by the  research group in Department  of

Engineering, at University of Hull, processes the data through the following stages:

5.2.1 Removal of advection

 Advection refers to the displacement of rain events across a scanned area. This

factor has to be removed from the rain fields before other processes are carried out.

The advection is removed so that  after interpolation,  to be implemented later, the

rain  events  can  evolve  smoothly  between  the  synthesised  scans,  and  more

importantly, to avoid errors in calculating rain fade time series values for radio links. 

5.2.2 Rain field downscaling

This stage comprises two steps;

 Disaggregation 

In disaggregation,  the data spatial  resolution is separated into smaller  parts.  The

original  CRIE data was captured with a resolution of 300 m by 300 m. Since for

simulation  of  radio  networks,  a  finer  resolution  is  preferable,  disaggregation  is

necessary.  The  programme  achieves  the  disaggregation  through  the  use  of  a

statistical  algorithm  called  the  Log  Poisson  Distribution,  and  scales  down  the

resolution to around 30 m by 30 m. The ultimate effect is that the synthesised data

matrix  possesses  more  pixels  with  estimated  values  between  the  original  radar

readings.  In practice, the smaller averaging volumes enable greater variation in rain

rate measurement, meaning very high rain rates can be measured accurately.

Interpolation

 Interpolation estimates the rain events values between the 10 minute scan periods

using  the  Random  Midpoint  Displacement  algorithm  (RDM).  This  algorithm

continuously cuts the scan interval into two, until the 10 minutes interval is broken

into numerous 10 second intervals. The rain events are estimated using the Hurst

exponent to fill in the rain rate values.

When the down scaling has been done, advection is then re-introduced into the rain
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events data. Now the rain events data carry the drifting tendency of the rain between

radar scans and the rain can spread appropriately on the map.

5.2.3 Calculation of rain attenuation time series

At this stage, on the rain map of values established above, an arbitrary radio link,

with two radio paths link 1 and link 2, is created in the rain area, as shown in Figure

6. The rain intensity is represented by the colour scale, where the red parts show

places of heaviest rain, and blue shows no rain at all.

Figure 6: Links on a rain data map

The rain rate estimates evaluated in section  5.2.2 are then used to calculate the

specific attenuations  �, along the radio links using equation (5). Every 10 seconds

the  summations  of  the  specific  attenuations  along  each  link  provide  the  total

attenuation. These form elements of the channel model.

5.3 Radio propagation models

OPNET has a number of  common radio propagation models  which  can be used
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within the package to simulate the attenuation for various environmental conditions;

for  instance,  the  Hata model which is designed  to  model  propagation in various

areas to calculate radio propagation for mobile radio reception. 

The  propagation model codes are available as open source C or  C++ language

codes within the OPNET application. They can be modified and developed by users

to suit the particular needs the user desires to address with the application.

The free space model was chosen for customisation to include rain fade. The model

was chosen because it is the least complex. It assumes there are no atmospheric,

environmental, and terrain (optional, as later described) effects on the radio waves

as they travel from the transmitter to the receiver. The only attenuation factor catered

for  in  the  model  is  the  free-space  attenuation;  that  is,  the  diminishing  of  signal

strength as the energy spreads into an ever increasing area of a sphere (ideally for

isotropic antenna) in travelling away from its source.

 Another  option the  model offers is the  LOS  on or  off choice.  With  LOS on,  the

programme determines if there are obstructions due to terrain,  or other obstacles

between the receiver and transmitter, and can decide to terminate the simulation if

the  obstruction  exists.  However,  for  the  envisaged  study,  no  terrain  or  actual

geographical  map would  be  invoked,  and  therefore  all  situations  would  be  LOS.

Hence the model was used in only the non-LOS mode. 

5.3.1 Using channel data in the propagation model 

An external file that has rain fade time series data, and whose creation is described

in section 5.2, provides the behaviour of the radio channel as a consequence of rain

existence  in  the  radio  path.  The  propagation  C/C++  language programme (open

source code available as part of OPNET) model was modified to:

1. Access the external data file with the rain fade time series data

2. Read and import the contents of the data into OPNET,

3. Apply the amplitude scaling according to the values imported from the rain

fade data to determine the receive level at the receivers.

The schematic in Figure 7 depicts the general idea of the way the time series data
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was used to simulate rain fade.

Figure 7: Propagation model program flow

Having acquired the data, the programme was further modified to use the data to

scale the signal strength as it travels from the transmitter to the receivers according

to the attenuation the channel imposed on the signal. This calculation was done in

addition to the free space attenuation inherent in the model. Therefore the received

signal at link end is:

������ �� ��������=�������� ���������� ���� ���������

����� ����+�����

The propagation model programme resides in the local  OPNET working directory

and can be modified independently outside OPNET. However, the code calls many

sub programmes, and depends on libraries within OPNET. Therefore, to compile and

run the model program, the model programme was imported into OPNET where it

could access all the ancillary resources needed for its execution. The customised

programme was successfully compiled.

Further, having created a compiled program, the next step was to create the running

environment for it. This involved building repository libraries linking the files within

OPNET and  where  the  various  processes can access the  necessary executable

codes to complete their tasks.

The libraries for the original free space model, available in OPNET working directory,
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Chapter Four � Project execution

were studied for modification to run with the customised model. However, the time

available was not enough for the task. The creation of shared libraries happens to be

a very complex undertaking which would need more time to appreciate. As a result

of the above, this part of the project was not completed. 
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Chapter Five - Study results and discussions

5.1 Working with OPNET, modelling and simulation 

The  first  achievement  of  the  study  has  been  gaining  working  knowledge  of  the

OPNET package. The basic building blocks to model modules, nodes and a network

were learned. 

The various functions of the models can be modified through the use of the many

attributes available which help one to model a situation and, through the available

statistics extracting methods, can learn the impact of the simulated scenarios in a

network.

Figure 8 and  Figure 9 show the simulation results the network model of  Figure 5.

They show the  impact  of  the  jammer on the selected statistics,  BER and packet

throughput, from different locations along the defined trajectory. 

Figure 8: BER and packet throughput for tx_1 in model in Figure 5
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Figure 9: BER and packet throughput for tx_2 in of model in Figure 5

And with reference to the topology of the network model in Figure 5, the BER rises

tremendously  when the  interferer  passes  through the  major  lobe  of  the  receiver

model antennas. This of course is accompanied by a fall in packets throughput as

expected. The duration of the BER blast lasts longer further away from the receiver

because the beam is wider there. 

The simulation results can alternatively be displayed in tabular form as demonstrated

by  Figure  10.  Here  statistics  of  packets  destroyed  within  the  individual  network

modules  are  shown.  Various  statistics  from  the  either  from  the  nodes  or  from

modules within nodes can be selected for analysis.

Figure 10: An example packet history for the simulation on model in Figure 5

From the limited use of OPNET that has been applied in the project, a lot could be

demonstrated as to how various network parameters can be varied and their effects

on the network be predicted with the use of the simulation package. 

Further, as one works through the package environment, many possibilities emerged
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Chapter Five � Study results and discussions

of the many telecommunications protocols, technologies, networks and systems that

can  be  investigated  and  analysed,  for  purposes  of  planning,  design  and

development,                                                      and learning using OPNET. 

The  advantage  offered  by  this  approach  is  the  visual  nature  of  demonstrating

network  objects,  which  helps  impart  in  the  user,  the  understanding  of  the

subcomponents and processes that in real hardware appear as black boxes that one

manipulates through inputs. 

5.2 Rain fade time series data

In Figure 11 below, the rain rates have been converted into specific attenuations (dB/

km)  and  subsequently  to  total  attenuations  in  dB  by  summing  the  specific

attenuations along the link path for both links in Figure 6.

The dB attenuations as depicted in Figure 6 represent the amount of rain fade the

link experiences, and are stored in a text file which OPNET accesses through the

customised radio propagation model. During simulations OPNET would read these in

for  the  appropriate link  and apply them on the radio signals  to calculate  receive

signal levels.

Figure 11: attenuation graphs
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Now, the two link attenuation profiles can be analysed and it is evident that link 1

experiences  significantly  more  attenuation than  link  1,  especially  in  the  first  1.5

minutes, and to a less extent in the next 1.5 minutes. This corresponds well with the

link locations on the rain map on Figure 6 which shows that link 2 path cuts through

more, and heavier rain than link 1.

The situation represents a scenario when link 1 would be relied upon to maintain the

connection availability despite the likely failure expected on link 2 in approximately

the first 1.5 minutes of the simulation.

Although these data were collected for a specific area, and can be applicable only for

that climatic type, the principle can be applied for other data collected from different

climatic regions.  

5.3 Integration of customised model into OPNET

This included the customisation of propagation model to include rain fade, creation of

shared  libraries  for  proper  running  of  the  model  within  OPNET,  and  running

simulations to study the impact of rain fade on a route diverse link experiencing rain

fade.

5.3.1 Customisation of the propagation model

The customised propagation model was successfully compiled. The new model can

access the generated external  data file  with rain fade time series data.  The time

series provides a dynamic series of rain fade levels, derived from the CRIE data.

These data provide updates every 10 seconds.

The  propagation  model  then  calculates  the  receive  signal  level  at  the  receiver

modules. The continuously updated signal receive level is used by the simulator to

evaluate the link BER and throughput more accurately, and the simulation results

can give a more reliable idea of the radio link performance in the presence of rain.

5.3.2 Shared libraries creation and rain fade simulation

In order for the customised propagation model to properly run within OPNET, shared

libraries and repositories had to be created.  It was not possible to complete the task

because of limited time as the process is complicated.
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5.4 Rain fade in route diverse links

The main aim of this project was to ultimately have rain fade simulated in OPNET

using radar measurement data. Rain fade presents one of the major challenges for

radio engineers in ensuring and maintaining availability of radio links, and one of the

common FMTs mode used is route diverse links.

Although the ITU recommendation ITU-R 837-12 provides a detailed treatment of

rain fade  for  LOS links  in the microwave frequency  region,  it  does not  give any

guidance on multi-hop and route diverse links. The idea of using statistical methods

to  determine  availability  is  useful  for  practical  applications  as  these  radio  link

configurations are widely used as FMTs. 

Simulations  run for  long enough time would provide BER and  packet  throughput

performance statistics from which the percentage of time of unavailability, as per ITU

criteria explained in section 3.3, could be deduced and compared with tolerable down

times for designing links. 

The  perfect  operation scenario  for  route  diverse  links  is  in  the  presence  of  de-

correlated rain (localised in the region of one of the link paths), which would affect

one of the links separately, leaving the other completely unaffected. In cases like

that, the link is maintained by switching the traffic to the unaffected path. This would

give 100% link availability. 

However, almost  all rain events affect  both paths simultaneously, but  mostly with

unequal fade levels. The least affected carries the traffic with some finite BER, and

the average of the BER over a year provides guidance for availability of the links

planners. 

As  noted  in the  previous  chapter,  the  simulation was not  completed as  the final

stages  of  building  software  links  did  not  work.  It  was  envisaged  the  statistics

obtained would be used to evaluate the overall availability of the link. 
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Chapter Six � Conclusions and future work

The main objectives of this project were to develop a working knowledge of OPNET,

generate fine scale rain time series for rain fade channel modelling from the CAMRa

data, customise the propagation model to include rain fade which is modelled by the

fine scale rain time series from radar measurements, and run the new propagation

model to establish availability statistics of a route diverse link.

5.5 Summary of study conclusions

The acclimatisation and learning of OPNET were achieved and demonstrated with

modelling and simulation of a radio link  model.  Some statistics were collected to

measure the BER and throughput given different locations of an interfering source.

Using methods developed in earlier studies, the fine scale rain time series data were

generated to model two arbitrarily placed links in a rain map. The coarse scale radar

acquired  rain  events  data  was synthesised  into  fine  scale  time series  for  better

application telecommunication radio network simulations. 

The customisation of the free space model to include rain fade was achieved and the

programme  successfully  compiled.   The  running  of  simulations  to  study  the

availability statistics of the route diverse link, using the customised propagation, was

not performed. This was because the development of shared libraries for the model

and OPNET was not completed. 

5.6 Future work on the project

OPNET is vast engineering tool which encompasses far more facilities than covered

in the current study. The successful inclusion of a rain fading procedure to run as

part  of  the  available  radio  propagation  models  would  allow  more  benefits  to  be

gained from the modelling and simulation capabilities the software offers, particularly

in the wireless modeller module. As a way forward:

· many of  the  capabilities  and  functionalities  can be explored for  implementing

studies of different communications technologies.

·  OPNET can be used, as a laboratory tool, in learning to enhance understanding

37



Chapter Six � Conclusions and future work

of the various communications protocols and networks.

· the creation of shared libraries for the current project can be completed, and the

customised propagation model properly tested by running it from OPNET. This

would probably reveal other bugs which require improvement of the propagation

model.  Such run time errors  may  not  be detected  without  the  full  run of  the

programme within the OPNET environment. 
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Appendix A � Creation of OPNET module models

To prepare for the simulation of the radio link with rain fade included, an appropriate

project is built in OPNET environment. The procedure followed here is adopt from

the  tutorial  �Creating  a  wireless  network�   in  the  OPNET  documentation,  and

introduces the necessary changes to suit the investigation at hand.

Antenna pattern model 

The schematic begins with the creation of the antenna module. First the antenna

pattern was produced. In the OPNET main window, follow the path: 

File > Open..., and choose Antenna Pattern from the pull-down menu. The antenna

pattern editor and 3D antenna pattern viewer windows appear.

The default setting for the number of polar planes and the number of azimuth values

per polar plane are left unchanged (36 and 72 respectively). 

Antenna pattern editor

Antenna pattern 3D viewer
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In the antenna pattern editor, the polar plane was adjusted to 5 degrees by selecting

5 in the pull-down menu near polar plane (phi).

Polar plane option values

The bounds on the ordinate were set using the upper and lower bound buttons (to

24.5 and 25.5, respectively) shown below, from the tool bar. The values were directly

entered into the dialogue box that appears when the buttons are pressed. The range

chosen resolves the scale to small intervals allowing easy setting of a gain of 25 dB

to great accuracy.

Lower and upper bound buttons

Now the sample points for the polar = 5 degrees were set as follows:

· The cursor was moved as close to the 25 dB mark as possible followed by

clicking on the first sample point on the horizontal, 0 (zero) degrees

· Next, the cursor was moved to the far right of the 25 dB line, and clicked on a

second point (close to 360 degrees).

All  the  points  between  the  specified  points  are  automatically  set  to  linearly

interpolated gain. 
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The sample points

After the polar = 5 degrees gain values, proceed to the polar = 0. This specifies a

gain of 25 dB for the planes 0 to 5 degrees and the azimuth of 0 to 360 degrees. 

The procedure goes as follows.

· In the antenna pattern editor, either 

o Press Ctrl + [up arrow], or

o Choose Antenna > Decrease Polar Plane

The plane changes from 5 to 0 degrees

· Verify the ordinate lower and upper bounds are 24.5 and 25.5 respectively

· On the 25 dB line, click at 0 degrees and again at the far right, close to 360

degrees.

The final 3D antenna pattern view
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The function was normalised over the entire pattern by pressing on the Normalize the

Function button, and the lines shifted up out of display.

The antenna pattern was saved as PROJ_mrt_cone, and the antenna pattern editor

was closed.

The antenna pointing processor

The antenna pointing processor calculates the position of the transmitter module and

sets antenna module targeting attributes. The processor was created as follows:

· Open File > New... and pick Process Model, then click OK.

o The process editor window opens

· With the Create State tool button,   place a state in the workspace

· Right click on the state and access the Set Name attribute field in the pop-up

menu

· The state was named point.

The already designed software code for the process model, used in the �Creating a

wireless network� tutorial was found adequate for  the function here and therefore

used. The code for the process model was imported into the model from the working

drive:
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· Double-click on the top half of the point state and the  Enter Executives block

opens

· Choose File > Import..., and then select the file 

<working drive>\15.0.A\models\std\tutorial_req\modeller\mrt_ex,

and click Import. The file is imported. This is the code created for the tutorial

and completely suffices for the simulation envisaged.

· The Enter Executives is then saved

The Enter Executives code defines the conditions that determine when a process

model enters a state. This contrasts the function of the Exit Executives which decide

when a state is exited.

The next task was to modify the process attributes, from the process model window:

· Choose Interfaces > Process Interfaces

· Set the value of the begsim intrpt attribute to enabled 

· Set the status of all other attributes to hidden

· Save the changes  by clicking OK
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Packet transmission is modelled with radio transceiver pipeline in wireless networks.

In this investigation, only closure stage of the pipeline (line of sight) was of interest.

Therefore, the C library that defines the function used for closure was included such

that it could be loaded when the simulation executes:

· Choose File > Declare External Files...

· Tick closure_support and then click OK

· The model was compiled by pressing the  Compile Process Model tool button,

· It was then saved as PROJ_mrt_rx_point
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In case the model does not compile, it can be edited as appropriate.

Creating the network node models

The radio network model for the simulation consists of two types of nodes, namely,

transmitters and receivers. The transmitter node model has a packet generator, radio

transmitter and antenna modules, feeding packets in that order. The receiver is built

from an antenna, radio receiver, packet sink, and the pointing processor modules.

The transmitter node

The packet generator module used in this project takes default values of 1024 bits

arriving at 1.0 packets per second with a constant inter-arrival time. The packets are

then  fed  to  the  transmitter  module  through  a  packet  stream,  whence  they  are

transmitted  at  a  rate of  1024  bits/second,  using  the  full  100% bandwidth  of  the

channel, to the antenna module. A directional antenna with 25 dB gain is used.

The transmitter node model was created as follows:

1. File > New..., from pull-down menu pick Node Model and click OK

The node editor appears. The node editor tool bar is shown below and the

functions of all the buttons pop-up as the cursor is passed over the button,

e.g. Create Processor as displayed.

2. The  Create  Processor,  Create  Radio  Transmitter,  Create  Antenna and  Create

Packet  Stream tool  buttons  were  used  to build  the  node.  After  clicking  the
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specific module button, the module can be dropped in the workspace by the

left mouse click. This can be repeated as many times as required depending

on  the  number  of  the  modules  required,  and  the  right  mouse  used  to

deactivate the create capability. 

3. Following the steps in 2., the models was constructed as shown below

4. The module names were modified by right clicking on them and accessing the

Edit Attributes or Set Name menu

To collect statistics from the network model, two ways can be used. One way is to

collect the statistics in the Project Editor, which is limited in some ways, and another

way is to use the more versatile Probe Editor. 

In order to run the parameterised simulations, the power attribute is promoted. This

means the power attribute can be changed easily during simulation run time.

To promote the power attribute, follow the steps;

1. Right click on radio_tx node and select Edit Attributes

2. From  the  transmitter  Attributes dialogue  box,  click  on  the  Value field  for

Channel attribute. The dialogue box for channel attributes table displays.

Transmitter attribute dialogue box with the channel attribute table on top
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3. Promote power by selecting its value and clicking the Promote button. 

The value for power then changes to promoted.

4. Clicking  OK on the channel table and the transmitter attributes closes both the

dialogue boxes.

The node model interface attributes were next defined:

1. Click Interfaces > Node Interfaces

2. On the  Nodes Interfaces dialogue box, in the  Node Types table, the  Supported

value was changed to no for mobile and satellite types. The effectively defines

the node as fixed.

3. In  the  Attributes table,  the  Status was  changed  to  hidden for  all  attributes

except the promoted power attribute.
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4. Click OK to save the changes

5. The node model was saved as follows:

a.  Click File > Save, 

b. Type PROJ_mrx_tx for the model name, then save.

The receiver node

The receiver node constructed as the transmitter node, the only difference being the

data stream direction:

1. Choose Edit > Clear Model, in the Node model editor window

2. The modules and data streams were created and named as shown below

The name of the antenna module is particularly important as it is referenced

by the antenna pointing processor, PROJ_mrt_rx_point as ant_rx.

The attributes were modified as follows:

1. Right click on rx_point and open the Set Attributes box.

2. Set the process model attribute to PROJ_mrt_rx_point, and click OK.
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3. In  the  radio_rx  attributes  dialogue  box,  set  the  value  of  error  model  to

dra_error_all_stats, and click OK.

4. The ant_rx pattern value was set to PROJ_mrt_cone (the pattern created in the

earlier section)

5. Click OK.

Finally, the node model interface attributes were defined:

1. Follow Interface > Node Interfaces

2. Change the value for Supported to no for mobile and satellite in the Node types

table

3. Set all attributes� status to hidden in the attributes table

4. Save changes by clicking OK

5. Choose  File >  Save as..., and save model as  PROJ_mrt_rx and close Node

Editor.
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Appendix B � Code included in free space propagation model

The following was the code added to the free space model to include the rain fade:

FILE* fp;

float scaleVar;2

fp = fopen("data/test.txt", "r");

if(fp == 0)

{

    printf("Error opening file");

    return -1;

    }

    while(fscanf(fp, "%f", &scaleVar) !=EOF)

    {

 path_loss_db  =  20.0  *  log10  (C_OVER_4PI  /  (center_frequency  *

propagation_dist_m)) - scaleVar;

    }

 path_loss_db  =  20.0  *  log10  (C_OVER_4PI  /  (center_frequency  *

2 These first two line cause an error if they appear under an FIN micro in the model programme (around
line 150). The cause of the problem could not be established.
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propagation_dist_m));
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